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Preface
For details, see the following topics:

•

Progress Corticon documentation

•

Overview of Progress Corticon

Progress Corticon documentation
The following documentation, as well as a What's New in Corticon document, is included with this
Progress Corticon release:
Corticon Tutorials
Corticon Studio Tutorial:
Basic Rule Modeling

Introduces modeling, analyzing, and testing rules and decisions in
Corticon Studio. Recommended for evaluators and users getting
started. See also the PowerPoint-as-PDF version of this document
that is accessed from the Studio for Analysts' Help menu.

Corticon Studio Tutorial: Provides a deeper look into Corticon Studio's capabilities by defining
Advanced Rule Modeling and testing vocabularies, scope, collections, messages, filters,
conditions, transient data, and calculations in multiple rulesheets that
are assembled into a Ruleflow. See also the PowerPoint-as-PDF
version of this document that is accessed from the Studio for Analysts'
Help menu.
Corticon Tutorial: Using
Enterprise Data
Connector (EDC)

Introduces Corticon's direct database access with a detailed
walkthrough from development in Studio to deployment on Server.
Uses Microsoft SQL Server to demonstrate database read-only and
read-update functions.
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Corticon Studio Documentation: Defining and Modeling Business Rules
Corticon Studio:
Installation Guide

Step-by-step procedures for installing Corticon Studio and Corticon
Studio for Analysts on computers running Microsoft Windows. Also
shows how use other supported Eclipse installations for integrated
development. Shows how to enable internationalization on Windows.

Corticon Studio: Rule
Modeling Guide

Presents the concepts and purposes the Corticon Vocabulary, then
shows how to work with it in Rulesheets by using scope, filters,
conditions, collections, and calculations. Discusses chaining, looping,
dependencies, filters and preconditions in rules. Presents the Enterprise
Data Connector from a rules viewpoint, and then shows how database
queries work. Provides information on versioning, natural language,
reporting, and localizing. Provides troubleshooting and many Test
Yourself exercises.

Corticon Studio: Quick
Reference Guide

Reference guide to the Corticon Studio user interface and its
mechanics, including descriptions of all menu options, buttons, and
actions.

Corticon Studio: Rule
Language Guide

Reference information for all operators available in the Corticon Studio
Vocabulary. A Rulesheet example is provided for many of the operators.
Includes special syntax issues, handling arithmetic and character
precedence issues.

Corticon Studio:
Extensions Guide

Detailed technical information about the Corticon extension framework
for extended operators and service call-outs. Describes several types
of operator extensions, and how to create a custom extension plug-in.

Corticon Server Documentation: Deploying Rules as Decision Services
Corticon Server:
Details installing the Corticon Server as a Web Services Server, and
Deploying Web Services then deploying and exposing Decision Services as Web Services on
with Java
Tomcat and other Java-based servers. Presents the features and
functions of the browser-based Server Console.
Corticon Server:
Details installing the Corticon Server as a Web Services Server, and
Deploying Web Services then deploying and exposing decisions as Web Services with .NET.
with .NET
Provides installation and configuration information for the .NET
Framework and Internet Information Services (IIS) on various supported
Windows platforms.
Corticon Server:
An in-depth, technical description of Corticon Server deployment
Integration & Deployment methods, including preparation and deployment of Decision Services
Guide
and Service Contracts through the Deployment Console tool. Discusses
relational database concepts and implementation of the Enterprise
Data Connector. Goes deep into the server to discuss state,
persistence, and invocations by version or effective date. Includes
samples, server monitoring techniques, and recommendations for
performance tuning.
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Overview of Progress Corticon
Progress® Corticon® is the Business Rules Management System with the patented "no-coding"
rules engine that automates sophisticated decision processes.

Progress Corticon products
Progress Corticon distinguishes its development toolsets from its server deployment environments.

• Corticon Studios are the Windows-based development environment for creating and testing
business rules:

• Corticon Studio for Analysts. is a standalone application, a lightweight installation that
focuses exclusively on Corticon.

• Corticon Studio is the Corticon Designer perspective in the Progress Developer Studio
(PDS), an industry-standard Eclipse and Java development environment. The PDS enables
development of applications integrated with other products, such as Progress OpenEdge.
The functionality of the two Studios is virtually identical, and the documentation is appropriate
to either product. Documentation of features that are only in the Corticon Designer (such as on
integrated application development and Java compilation) will note that requirement. Refer to
the Corticon Studio: Installation Guide to access, prepare, and install each of the Corticon
Studio packages.
Studio Licensing - Corticon embeds a time-delimited evaluation license that enables
development of both rule modeling and Enterprise Data Connector (EDC) projects, as well as
testing of the projects in an embedded Axis test server. You must obtain studio development
licenses from your Progress representative.

• Corticon Servers implement web services for business rules defined in Corticon Studios:
• Corticon Server for deploying web services with Java is supported on various application
servers, and client web browsers. After installation on a supported Windows platform, that
server installation's deployment artifacts can be redeployed on various UNIX and Linux web
service platforms as Corticon Decision Services. The guide Corticon Server: Deploying web
services with Java provides details on the full set of platforms and web service software that
it supports, as well as installation instructions in a tutorial format for typical usage.

• Corticon Server for deploying web services with .NET facilitates deployment of Corticon
Decision Services on Windows .NET Framework and Microsoft Internet Information Services
(IIS). The guide Corticon Server: Deploying web services with .NET provides details on the
platforms and web service software that it supports, as well as installation instructions in a
tutorial format for typical usage.
Server Licensing - Corticon embeds a time-delimited evaluation license that enables evaluation
and testing of rule modeling projects on supported platform configurations. You must obtain
server deployment licenses and server licenses that enable the Enterprise Data Connector
(EDC) from your Progress representative.

Progress Corticon: Installation Guide: Version 5.3.4
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Overview of Corticon Studio installations and
upgrades
What Corticon Studio installers provide
When you install either Corticon Studio, the installation includes:

• Studio resources and online documentation as plugins
• Java Runtime Environment (JRE)
• Sample projects
• Tutorials
In addition, the full Corticon Studio installs:

• When chosen, the Eclipse Development Environment and Eclipse online documentation. You
could choose to install (or apply an update site) into an existing Eclipse such as Progress
OpenEdge.

• JavaDoc
• Corticon Server WAR file at Server\axis.war file, specifically for use in development of
Progress OpenEdge Business Rules.

Supported platforms for Corticon Studio installations
Confirm that your target platform is supported. Connect to the Progress Software web page Progress
Corticon 5.3 - Supported Platforms Matrix for more information to review the currently supported
Corticon Studio operating systems, Eclipse versions, and EDC database brands.

Progress Corticon: Installation Guide: Version 5.3.4
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Installation options
When you choose the Corticon Studio for Analysts as your download, the installation is
straightforward on a supported Windows platform.
However, the full Corticon Studio lets you choose to add Corticon Studio to Progress Developer
Studio for Open Edge or other existing Eclipse installation:
Download and Run the Wizard - See Downloading Corticon Studio installer packages and
Downloading and running the Corticon Studio installers and updaters on page 13.

• Use the downloaded installer to install the Studio with all the required Java and Eclipse resources.
• Use the downloaded installer to install the Studio as a plug-in to an existing installation of
Progress Developer Studio for OpenEdge 11.3.
Connect to the Update Site - See Using the update site to install Corticon into an existing Eclipse
on page 23.

• Connect to the update site to install the Studio as a plug-in to an existing 3.7.1 Eclipse installation
that does not have Progress Developer Studio for OpenEdge 11.3 installed.

12
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Downloading and running the Corticon
Studio installers and updaters
Downloading Corticon Studio installer packages
Corticon Studio products and their respective Service Packs are packaged in executable installer
applications:

• The 5.3.0 installers to perform new installations:
• The full Eclipse-based product, PROGRESS_CORTICON_5.3_STUDIO.exe.
• The standalone application for analysts,
PROGRESS_CORTICON_5.3_STUDIO_FOR_ANALYSTS.exe

• The corresponding 5.3.4 Service Pack installer to update an existing 5.3.3, 5.3.2, 5.3.1, or 5.3.0
installation:

• For the full Eclipse-based product, PROGRESS_CORTICON_5.3.4_STUDIO.exe.
• For the standalone application for analysts,
PROGRESS_CORTICON_5.3.4_STUDIO_FOR_ANALYSTS.exe
To download the required installers:
1. Get credentials to access and download packages on the Progress Software Electronic Software
Download (ESD) site.
2. Connect to the ESD, and then navigate to the Corticon 5.3 pages.
3. Locate, download, and save the required installers to a temporary location accessible by the
target machine.

Progress Corticon: Installation Guide: Version 5.3.4
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Installation type
There are three types of Corticon Studio installations:

• New 5.3.4 installation - Perform a new installation, then update it with the corresponding 5.3.4
Service Pack.

• Update a 5.3.3, 5.3.2, 5.3.1, or 5.3.0 installation with the latest Service Pack - Apply the
5.3.4 Service Pack. Note that a higher Service Pack in a version rolls up the features of all
preceding Service Packs.

• Upgrade a 5.2 or earlier installation to the latest 5.3 Service Pack - An installed version of
Corticon Studio 5.2 or earlier installed on the target machine must be uninstalled, then the
preferred Corticon 5.3.0 Studio installed, followed by applying its appropriate 5.3.4 Service
Pack.
Consult with Progress Corticon Support or your Progress representative to consider your
migration strategies for existing assets before you take action.

Installation technique
The downloaded installers launch an interactive user interface that steps through the process. See
the next topic, Performing a new installation using the Installer Wizard, for details. If you prefer an
unattended installation, review the choices in the installer GUI panels, and then see the topic
Performing Silent Installations for detailed instructions on creating and using response files to
perform silent installations.

Before running installers
To avoid possible constraints on the installer, do the following:

• Confirm that you have Administrator permissions on the workstation - Administrator rights
allow the installer to copy all the Corticon Studio files to their proper locations. You must have
Administrator rights and permissions to install this software. See your system administrator to
obtain these rights.

• Obtain system access - Several Corticon Studio features write files to the “home” directory
structure. If the target machine for the Corticon Studio installation does not have read and write
access to this directory, you will need to choose a directory location where the Corticon Studio
user will have both read and write access.

• Disable anti-virus, anti-malware, and anti-spyware protection applications - Before
performing the installation, we highly recommend temporarily disabling any anti-virus and
anti-spyware software that may be running on your machine. This software often prevents or
interferes with correct installation.
For details, see the following topics:
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•

Performing a new installation using the Installer Wizard

•

Applying a Service Pack update

•

Performing Silent Installations

•

Uninstalling Corticon Studios installed from downloaded installers
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Performing a new installation using the Installer Wizard

Performing a new installation using the Installer
Wizard
To perform a new installation of Corticon Studio 5.3.0:
1. Double click on the appropriate installer file,
PROGRESS_CORTICON_5.3_STUDIO_FOR_ANALYSTS.exe or
PROGRESS_CORTICON_5.3_STUDIO.exe, to launch the Corticon Studio installer.
The installer opens in the installer wizard.
Note: The following panels capture the Corticon Studio for Analysts installation except for the
two panels that are unique to the full Corticon Studio installer.
2. The first installer panel opens with information about the installer.

3. Click Next to continue.
The License Agreement panel opens.

Progress Corticon: Installation Guide: Version 5.3.4
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This screen displays the Progress Software End User License Agreement (EULA). Use the
scroll bar at the right of the screen to read the agreement content.
4. When you understand and agree to the terms, choose I accept the terms in the license
agreement, and then click Next to continue.
The Choose Install Folder panel opens.
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Performing a new installation using the Installer Wizard

5. Specify the installation location. The default location for the installation directory and the work
directory are as shown above. (For the work directory, the default subdirectory under Users
is the current username.) Either accept the default locations, or specify each preferred (and
different) location.
When you have the locations specified, click Next to continue.
A Corticon Studio for Analysts installation is now ready to run, so skip ahead to 7 on page 18
A full Corticon Studio opens the External eclipse configuration panel:

6. You can select Yes on this panel to expose the entry area for the External Eclipse location
where you want to plug in the Corticon Studio:

Progress Corticon: Installation Guide: Version 5.3.4
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If you leave the selection as No, the required Java and Eclipse will be installed.
Note: If you elect to use an existing Eclipse, you must perform the tasks in Using the update
site to install Corticon into an existing Eclipse on page 23 to complete the integration.
When you have decided which path to take, click Next to continue.
7. The Pre-Installation Summary panel opens.
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Applying a Service Pack update

In the Pre-Installation Summary, confirm that your installation location has adequate disk space
for the Corticon Studio components as well as 100 MB of workspace.
8. Click Install to continue.
An installation status window opens to display the state of the installation process.

When the process has finished, the Install Complete panel opens.
9. Click Done to quit and close the installer.

Applying a Service Pack update
To update a 5.3.3, 5.3.2, 5.3.1, or 5.3.0 installation of Corticon Studio to this Service Pack:
1. If the installed Corticon Studio you want to update is running, stop it now.
2. Double click on the appropriate update installer file,
PROGRESS_CORTICON_5.3.4_STUDIO_FOR_ANALYSTS.exe or
PROGRESS_CORTICON_5.3.4_STUDIO.exe, to launch the Corticon Studio updater.
The installer prepares, and then opens the update wizard. Note the revised Progress branding
scheme in the 5.3.4 update wizards:
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3. Click Next through the panels, and then click Install.
When the appropriate 5.3 installation is detected, and it is determined that this Service Pack has
not already been applied, the updater proceeds to complete the update of the installation.
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Performing Silent Installations
An unattended (silent) install requires that you first run an installation or updater in the installer
wizard to capture the selected options, and then use the captured response file on other targets
to 'playback' the responses into the installer without any user interaction.
To perform silent installations for either Studio:
1. Run the installer with your preferred locations and options to capture a response file, using the
syntax installer.exe -r file where installer is the preferred Studio installer or
updater, and file is the response file you will reuse. For example,
PROGRESS_CORTICON_5.3_STUDIO_FOR_ANALYSTS.exe -r C:\S4A_530.responses
2. On other target machines, access the installer executable and the response file.
3. Run the installer using the syntax installer.exe -i silent -f file where installer
is the preferred Studio installer or updater, and file is your response file. For example,
PROGRESS_CORTICON_5.3_STUDIO_FOR_ANALYSTS.exe -i silent -f
C:\S4A_530.responses.

Uninstalling Corticon Studios installed from
downloaded installers
To remove a version of Corticon Studio that was installed by the installer to prepare for a new
installation (or if you want to fully remove it), use this procedure. The major.minor product version
and all applied service packs are removed by the uninstaller.
To uninstall any version of Corticon Studio for Analysts:
To remove a version of the Studio to prepare for a new installation (or if you want to fully remove
it), use this procedure.
Note: This applies only to a Corticon Studio that you installed with the installer, not an installation
added to an existing Eclipse through the Update Site technique.
To uninstall any version of Corticon Studio:
1. Backup any files you want to retain.
2. Navigate to [CORTICON_HOME]\Uninstall Progress Corticon Studio.
3. Run Uninstall Progress Corticon Studio.exe.
The installed files are removed. Note that files you created are NOT removed or replaced during
this process.
If the Uninstaller program is unable to fully remove components (usually because they are open),
it will display messages, and might require a reboot to complete the process.
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Using the update site to install Corticon into
an existing Eclipse
These instructions apply when you want to install Corticon functionality into your own Eclipse IDE.
For example, you can install Corticon plug-ins into the Eclipse Classic platform for Java developers,
or any custom Eclipse platform (Eclipse 3.6.0 or later).
Note: Where the product installers require that you install 5.3.0 and then apply 5.3.4, this technique
requires only one step as the 5.3.4 update site package is the complete package.
Tasks to complete Corticon Studio plug-in installation
1. A Java Software Development Kit is required. If you do not have one installed locally, download
and install a version specified in the preceding table from the Oracle Java website
http://www.oracle.com/technetwork/java

Note: A complete JDK is required, not just a Java Runtime Environment (JRE).
2. If you do not have an Eclipse installation locally, download the "Indigo" version of Eclipse from
www.eclipse.org. Unzip the file into your Eclipse directory (for example, C:\eclipse).
3. Login to the Progress Software Electronic Software Download (ESD) site, and then navigate
to the Corticon 5.3 release. Download PROGRESS_CORTICON_5.3.4_UPDATESITE.zip, and
then unpack into a clean temporary installation directory, such as C:\CorticonLocalSite).
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4. Start the Eclipse IDE by double-clicking on eclipse.exe in the C:\eclipse directory. The
system will prompt for a workspace location

5. Either accept the default location, or choose a preferred location. Click OK to continue. Eclipse
opens to the Welcome View.
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6. Close the Welcome View, then select menu command Help > Install New Software

7. Click the Add… button. Eclipse opens the Add Site dialog:

8. Click Local and navigate to the C:\CorticonLocalSite directory :
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9. Click OK, and then assign your new site a name you want:

10. Click OK again to add the new site
11. Select Corticon > Progress Corticon Studio
12. Click Next >. Eclipse analyzes the dependencies and shows the complete set of features to
be installed, including GMF, GEF and EMF
13. Click Next > to review the licenses.
14. Select I accept the terms of the license agreement and click Finish
15. When Eclipse displays the Security Warning dialog box, click OK
16. When the system prompts regarding certifications, select Eclipse.org and click OK
17. Eclipse installs all of the necessary plug-ins. When the system is finished, click Yes to restart
the Eclipse session

18. Once Eclipse restarts, verify the installation by selecting menu item Help > About Eclipse
SDK, then press the Installation Details button
19. Note that Corticon Studio has been successfully installed
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20. Exit from Eclipse and create a Windows icon shortcut on your Windows desktop to make it
easier to launch eclipse.exe. Update the Target and Start In fields as shown:

21. The Target field command line parameters should specify the proper JDK (for example, -vm
c:\jdk1.7.0_05\bin), and should increase the memory heap settings for optimal performance
(for example, -vmargs –Xms256m –Xmx1024m). Example:
C:\eclipse\eclipse.exe -vm c:\jdk1.7.0_05\bin -vmargs –Xms256m –Xmx1024m
22. Use your new shortcut to restart Corticon Studio. You can now switch to the "Rule Modeling"
Perspective to create your first Rule Project.
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Updating your Corticon license in Studio
Progress Corticon embeds an evaluation license in its products to help you get started.

• Corticon Studio evaluation licenses let you use database access (Enterprise Data Connector
or "EDC"), and are timed to expire on a preset date. While you typically do not need to acquire
a license for Studio during evaluation and early stage development, in the event that you are
alerted that your license is invalid or expired, contact your Progress Corticon representative to
obtain a workable license.

• Corticon Server evaluation licenses do not enable use of Enterprise Data Connector, and limit
the number of decision services, rules, and pools in use. They too are timed to expire on a
preset date. You will need to obtain a license that enables EDC on Corticon Server for that
section of the EDC tutorial.
This document focuses on the Corticon Studio procedures for updating a license. See the Corticon
Server and EDC tutorials for the procedures on their registration of the license for the Corticon
Server and its Deployment Console.
Note: Locate your Corticon license JAR on the target machine or at a location that is
network-accessible to the installation. In this example, the license file, CcLicense.jar, that both
Studio and Server will use is placed at C:\licenses. Some users prefer to locate the license
files within the product installation location, typically the installation's /lib directory.
To configure Corticon Studio for database access:
1. Start Corticon Studio by choosing Start>All Programs>Progress>Corticon 5.3>Corticon
Studio for Analysts.
2. Select the menu command Window > Preferences.
3. Expand the Progress Corticon group, then click on Rule Modeling.
4. Choose the User Role option Integration and Deployment.
Progress Corticon: Installation Guide: Version 5.3.4
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5. If you have been issued a license file, enter its location into the License File entry area, or
browse to its location, as in this example:
Figure 1: For Studio, Setting the User Role for EDC and the License Path

6. Click OK.
7. Restart the Studio.
When EDC is enabled, a Vocabulary in Corticon Studio displays its Database Access tab , as
shown:

Licensing of Corticon Server embedded in the Corticon Studio's OpenEdge
distribution
To facilitate the integration of OpenEdge with Corticon, Corticon Studio includes the WAR file to
enable running Corticon Server from the Studio. The embedded Studio license for Corticon Server
has the following constraints:

• Corticon Server requests must originate on the machine where the server is running -- in other
words, all on localhost. Requests from any other machine or host are not allowed.

• Corticon Server allows only one reactor for execution of one instance of a specified Decision
Service. As a developer, you can locally deploy many Decision Services simultaneously, and
you can use administrative functions, such as service availabilities. When you are ready for
production system testing, you must obtain a Corticon Server deployment license, and then
locate it in Corticon Server installations.
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Changing the Studio's memory allocation
To change the studio memory allocation:

• In a Corticon Studio for Analysts installation, edit the command file named Studio.ini in
[CORTICON_HOME]\Studio

• In a full Corticon Studio installation, edit the command file named eclipse.ini in
[CORTICON_HOME]\Studio\eclipse
Change (typically, increase) the Xmx value (maximum memory setting). The default Xmx setting is
350 megabytes, specified as Xmx350m.
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Enabling Studio internationalization
Localizing your rule modeling and processing environment involves three related functions:

• Displaying the Studio program in your locale of choice. This means switching the Corticon
Studio user interface (menus, operators, system messages, etc.) to a new language. This part
is described here.

• Displaying your Studio assets in your locale of choice. This means switching your Vocabularies,
Rulesheets, Ruleflows, and Ruletests to a new language. See "Localizing Corticon Studio" in
the Rule Modeling Guide.

• Requests submitted to a Corticon Server can specify an execution property that indicates the
locale of the incoming payload so that the server can transform the payload's decimal and
date values to the decimal delimiter and month literal names of the server, run the rules, and
return the output formatted to the submitter's preference. See "Handling requests and replies
across locales" in the Server Integration and Deployment Guide.

Displaying Studio in your locale of choice
When localized, Corticon Studio can:

• Display its full user interface in localized languages and fonts.
• Display all operators in the Operator Vocabulary in localized languages and fonts.
• Process XML messages (or Test inputs) containing data comprised of non-Latin characters
(for example, Japanese, Chinese or Korean).

• Post Rule Statements that contain non-Latin characters.
In order for Studio to display its user interface in your chosen locale, two requirements must be
satisfied:
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1. A language "bundle" or template must be created for your chosen language and installed in
CcI18nBundles.jar, both Studio and all deployed Server installations.
2. Your operating system must be running in your chosen locale when Studio starts up.

Creating a new language bundle
To create a new language bundle for Corticon Studio, you need to download the Localization
Toolkit for your version. Toolkits are available for all versions of Corticon Studio, and are normally
available from the Corticon Support Site. The Toolkit contains a ReadMe that describes how to
create a new bundle, save it, and install it.

Switching operating system locales
Before switching to a different locale, you may need to install necessary language support into the
Windows operating system and set the appropriate Regional Settings in the Regional and Language
Options.

Installing language support in Windows
You must add the preferred input languages into the Windows operating system. This procedure
follows the Windows 7 control panel interface. Other operating systems might vary.
1. From the Start menu, choose Control Panel.
2. In the Region and Language section, choose the Keyboards and Languages tab, and then
click Change keyboards.
3. Click Change Languages.
The Text Services and Input Languages dialog box opens:
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4. The installed languages are listed. Click Add to select preferred languages and their features.

Changing your machine's region
Next, you must change you regional settings so that your machine's locale specifies a non-English
language that you have installed. You must change it in both the Keyboards and Languages
specification and the Location specification.
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For example, to enable Japanese, choose the specifications shown below:

Testing the setup
Start Corticon Studio in the normal manner, and invoke the open dialog window by selecting menu
option File > Open.
If the installation was successful, buttons on the dialog (and other key static text labels) should be
presented in the selected region's language.
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Third party acknowledgments
One or more products in the Progress Corticon v5.3.4 release includes third party components
covered by licenses that require that the following documentation notices be provided:
Progress Corticon v5.3.4 incorporates Apache Commons Discovery v0.2 from The Apache Software
Foundation. Such technology is subject to the following terms and conditions: The Apache Software
License, Version 1.1 - Copyright (c) 1999-2001 The Apache Software Foundation. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.
3. The end-user documentation included with the redistribution, if any, must include the following
acknowlegement: "This product includes software developed by the Apache Software Foundation
(http://www.apache.org/)." Alternately, this acknowledgement may appear in the software itself, if
and wherever such third-party acknowledgements normally appear.
4. The names "The Jakarta Project", "Commons", and "Apache Software Foundation" must not be
used to endorse or promote products derived from this software without prior written permission.
For written permission, please contact apache@apache.org.
5. Products derived from this software may not be called "Apache" nor may "Apache" appear in
their names without prior written permission of the Apache Group.
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THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This software consists of voluntary contributions made by many individuals on behalf of the Apache
Software Foundation. For more information on the Apache Software Foundation, please see
<http://www.apache.org/>.
Progress Corticon v5.3.4 incorporates Apache SOAP v2.3.1 from The Apache Software Foundation.
Such technology is subject to the following terms and conditions: The Apache Software License,
Version 1.1 Copyright (c) 1999 The Apache Software Foundation. All rights reserved. Redistribution
and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met: 1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must
reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution. 3. The end-user documentation
included with the redistribution, if any, must include the following acknowledgment: "This product
includes software developed by the Apache Software Foundation (http://www.apache.org/)."
Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party
acknowledgments normally appear. 4. The names "SOAP" and "Apache Software Foundation"
must not be used to endorse or promote products derived from this software without prior written
permission. For written permission, please contact apache@apache.org. 5. Products derived from
this software may not be called "Apache", nor may "Apache" appear in their name, without prior
written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED ``AS
IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary
contributions made by many individuals on behalf of the Apache Software Foundation. For more
information on the Apache Software Foundation, please see <http://www.apache.org/>.
Progress Corticon v5.3.4 incorporates DOM4J v1.6.1. Such technology is subject to the following
terms and conditions: Project License BSD style license Copyright 2001-2005 (C) MetaStuff, Ltd.
All Rights Reserved.
Redistribution and use of this software and associated documentation ("Software"), with or without
modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.
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3. The name "DOM4J" must not be used to endorse or promote products derived from this Software
without prior written permission of MetaStuff, Ltd. For written permission, please contact
dom4j-info@metastuff.com.
4. Products derived from this Software may not be called "DOM4J" nor may "DOM4J" appear in
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark
of MetaStuff, Ltd.
5. Due credit should be given to the DOM4J Project - http://www.dom4j.org
THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE
LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress Corticon v5.3.4 incorporates Jaxen v1.0. Such technology is subject to the following
terms and conditions: JAXEN License - $Id: LICENSE,v 1.3 2002/04/22 11:38:45 jstrachan Exp $
- Copyright (C) 2000-2002 bob mcwhirter and James Strachan. All rights reserved. Redistribution
and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials provided
with the distribution.
3. The name "Jaxen" must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact license@jaxen.org.
4. Products derived from this software may not be called "Jaxen", nor may "Jaxen" appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).
In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:
"This product includes software developed by the Jaxen Project (http://www.jaxen.org/)."
Alternatively, the acknowledgment may be graphical using the logos available at
http://www.jaxen.org/. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE Jaxen AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE. This software consists of voluntary contributions made by many individuals on behalf
of the Jaxen Project and was originally created by bob mcwhirter <bob@werken.com> and James
Strachan <jstrachan@apache.org>. For more information on the Jaxen Project, please see
<http://www.jaxen.org/>.
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Progress Corticon v5.3.4 incorporates JDOM v1.0 GA. Such technology is subject to the following
terms and conditions: $Id: LICENSE.txt,v 1.11 2004/02/06 09:32:57 jhunter Exp $ - Copyright (C)
2000-2004 Jason Hunter and Brett McLaughlin. All rights reserved. Redistribution and use in source
and binary forms, with or without modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials provided
with the distribution.
3. The name "JDOM" must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact
<request_AT_jdom_DOT_org>.
4. Products derived from this software may not be called "JDOM", nor may "JDOM" appear in their
name, without prior written permission from the JDOM Project Management
<request_AT_jdom_DOT_org>.
In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:
"This product includes software developed by the JDOM Project (http://www.jdom.org/)."
Alternatively, the acknowledgment may be graphical using the logos available at
http://www.jdom.org/images/logos. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by
many individuals on behalf of the JDOM Project and was originally created by Jason Hunter
<jhunter_AT_jdom_DOT_org> and Brett McLaughlin <brett_AT_jdom_DOT_org>. For more
information on the JDOM Project, please see <http://www.jdom.org/>.
Progress Corticon v5.3.4 incorporates Saxpath v1.0. Such technology is subject to the following
terms and conditions: Copyright (C) 2000-2002 werken digital. All rights reserved. Redistribution
and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials provided
with the distribution.
3. The name "SAXPath" must not be used to endorse or promote products derived from this
software without prior written permission. For written permission, please contact
license@saxpath.org.
4. Products derived from this software may not be called "SAXPath", nor may "SAXPath" appear
in their name, without prior written permission from the SAXPath Project Management
(pm@saxpath.org).
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In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:
"This product includes software developed by the SAXPath Project (http://www.saxpath.org/)."
Alternatively, the acknowledgment may be graphical using the logos available at
http://www.saxpath.org/ THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE SAXPath AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE. This software consists of voluntary contributions made by many individuals on behalf
of the SAXPath Project and was originally created by bob mcwhirter <bob@werken.com> and
James Strachan <jstrachan@apache.org>. For more information on the SAXPath Project, please
see <http://www.saxpath.org/>.
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